
 



 



 

 

 

Finite Element Analysis of a Cantilever Beam 

(Eigensolution – Solid Model) 

 Cantilever Beam Tutorial (Solid Model)  
© Dassault Systèmes, 2011                                                              SIMULIA Learning Community 

 

Programs Utilized: Abaqus/CAE Student Edition 6.10-2 

 

Problem Description: 

This tutorial illustrates how to build and compute a frequency analysis of an aluminum 

cantilever beam. Finite element models using solid elements will be analyzed. A 

subsequent tutorial completing the same example using beam elements can be found at 

www.simulia.com/learning. The pre-processing program used is Abaqus/CAE Student 

Edition 6.10-2, and Abaqus command is used for the analysis. The geometry and material 

properties of the cantilever beam section are shown in Figure 1 and Table 1, respectively.  

 

 
 

Figure 1. Beam Dimensions and BC’s 

 

 

Property Value 

L (m) 1.0 

t (m) 0.05 

w (m) 0.2 

Elastic Modulus (Pa) 73x10
9
 

Density (kg/m
3
) 2700 

Poisson’s Ratio 0.3 

Table 1. Corresponding Dimensions and Material Properties 
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Creating the Model Geometry (Solids) 

 Go to the Start Menu and open Abaqus CAE 

 You may be prompted with an Abaqus/CAE 6.10 Student Edition box (Figure 

2). Close this box by clicking the X in the top right hand corner.  

 
Figure 2. Abaqus/CAE 6.10 Student Edition box 

  

 Once the Student Edition box is exited, the Abaqus CAE Viewport should look 

similar to Figure 3. (Please note the model tree is the series of functions listed on 

the left hand side of the viewport, while the module is the list of icons to the right 

of the model tree) 

 
Figure 3. Abaqus CAE Viewport 

 To create the solid model geometry of the cantilever beam, a rectangle must be 

generated.  

 Using the left mouse button, double click Parts in the model tree and the Create 

Part (Figure 4a) dialog box appears. Enter a new Name: for the part (SOLID), 

Model Tree 
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and under the Base Feature tab choose Solid for Shape and Extrusion for Type. 

Change the Approximate size: option from the default 200 to 10. The Create 

Part dialog box should look identical to Figure 4b. 

 Click Continue… and the graphics window will change to a set of gridlines.  

 

                                          
              Figure 4a. Create Part Dialog Box        Figure 4b. Create Part Dialog Box (SOLID) 

 

 Click the Create Lines: Rectangle (4 Lines) icon  in the module. In the 

viewport click once with the cursor, then drag the cursor to any other place in the 

viewport and click again. A yellow rectangle should be visible in the viewport. 

(Please note, when the rectangle is created, the feature is exited by clicking the 

Esc key on your computer keyboard.) 

 NOTE:  If you accidentally create an unwanted rectangle or line, you can select 

Edit > Delete from the dropdown menu at the top of the screen and use the mouse 

to select a line to delete. 

 Click the Add Dimension icon  in the module. Click one of the horizontal 

lines of the rectangle and drag the cursor away from the line, and click. This will 

reveal the arbitrary length of the line in red.  

 At the bottom of the viewport enter a New dimension: for the line. Enter 1.0 in 

the box since the total beam length is 1.0 m. Hit Enter. The correct length of the 

line will update in the viewport.  

 Next, click one of the vertical lines of the rectangle and drag the cursor away from 

the line, and click. Update this dimension to 0.05. Hit Enter. 

 Press Esc on the computer keyboard to exit the dimensioning tool. 

 Click Done. 
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 The Edit Base Extrusion dialog box will appear. Change Depth: to 0.2 and click 

OK. Sketch mode will automatically be exited, and the model geometry should 

look identical to the beam shown in Figure 5.  

 
Figure 5. Final Model Geometry 

 

Defining Material Properties 

 To define material properties for this model, double click on Materials in the model tree 

and the Edit Material dialog box will appear (Figure 6a). Enter a Name: for the material 

(ALUM), and click the Mechanical tab, highlight Elasticity and click Elastic.  Enter 

values of Young’s Modulus = 73E09 Pa, and Poisson’s Ratio = 0.3. After the material 

properties have been entered, the Edit Material dialog box should look identical to 

Figure 6b.  

                                     
              Figure 6a. Edit Material Dialog Box      Figure 6b. Edit Material Dialog Box (ALUM) 



   

 Cantilever Beam Tutorial (Solid Model)  
© Dassault Systèmes, 2011                                                              SIMULIA Learning Community 

5 

 
 Next, click the General tab, and then click Density. Enter a value of 2700 for Mass 

Density. The Edit Material dialog box should look similar to that in Figure 7.  

 
Figure 7. Final Edit Material Dialog Box (ALUM) 

 Click OK. 

 Please note there is no dropdown menu or feature in Abaqus that sets specific units.  All 

of the dimensions have been input in meters; therefore the respective Young’s Modulus 

units should be entered in Pa (Pascals).  The units chosen for the definition of the 

material properties should be consistent and dictate what units should be used for the 

dimensions of the structure.  

 At this point in preprocessing, the model should be saved. Click File then click Save. 

Name the file Cantilever Tutorial 2. The file will save as a Model Database (*.cae*) 

file. It may be of interest to save the file after each section of this tutorial.  

Creating Sections (and Profiles) 

 To create a solid section in Abaqus, double click Sections in the model tree and 

the Create Section dialog box will appear (Figure 8a). Enter a Name: for the 

section (SOLID), and ensure Solid is selected under the Category Tab, and 

Homogeneous under the Type tab. Your Create Section dialog box should look 

identical to that in Figure 8b.  

 Click Continue…  
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       Figure 8a.  Create Section Dialog Box       Figure 8b. Create Section Dialog Box (SOLID) 

 

 The Edit Section dialog box will then appear where a Material can be prescribed 

for this section.  Because only one material has been created, the Material: is 

defaulted to ALUM. If multiple materials had been created, the dropdown menu 

could be used to prescribe a different material to this section. The Edit Section 

dialog box should look similar to that in Figure 9. 

 
Figure 9. Edit Section Dialog Box 

 Click OK. 

Assigning Sections 

 Now that the solid section has been created, it can be assigned to the geometry. In the 

model tree, click the + to the left of the Parts (1) icon, this will further expand the model 

tree’s options. Next, click the + to the left of the part called SOLID, further expanding 

the model tree (Figure 10). 
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Figure 10. Model Tree Expansion (Parts) 

 

 After the model tree has been expanded, double click Section Assignments. Use the 

cursor to draw a box around the whole model. If this has been done correctly, the outline 

of the geometry will change to the color red. Click Done.  

 The Edit Section Assignment dialog box will appear (Figure 11). Because only one 

section has been created, the dropdown menu defaults to the SOLID section. If multiple 

sections had been created, the dropdown menu could be used to assign different sections 

to different parts of the geometry.  

 
Figure 11. Edit Section Assignment Dialog Box (SOLID) 

 

 Click OK. The model now should now turn to a turquoise color (Figure 12). 
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Figure 12. Assigned Section 

 

Creating a Mesh 

 To create a mesh for the model geometry, double click Mesh (Empty) in the 

model tree.  If this selection is done correctly, then the geometry should change 

color to green. 

 The first step in creating a mesh is to seed the part edges. Click the Seed Edges 

icon  in the mesh module.  

 Using the cursor draw a box around the whole model, if this is done correctly the 

model edges will turn a red color.  

 Click Done. 

 The Local Seeds dialog box will appear (Figure 13a). Under the Basic tab ensure 

the Method is set to By size, and under the Sizing Controls option change the 

Approximate element size: to 0.05. The Local Seeds dialog box should look 

similar to Figure 13b. 
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        Figure 13a. Local Seeds Dialog Box                   Figure 13b. Local Seeds Dialog Box (0.05) 

 

 Click OK. The model will now appear to be seeded with evenly spaced pink 

points along its edges Figure 14. 

 
Figure 14. Seeded Geometry  

 Click Done. 

 The part is now ready to be meshed. In the mesh module, click the Mesh Part 

icon   . At the bottom of the viewport you will be prompted if it is OK to mesh 

the part? Click Yes. 

 If this procedure was done correctly, the geometry will turn blue and a visible 

mesh will appear (Figure 15). 
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Figure 15. Final Meshed Geometry 

 

 Finally, the proper element type will be assigned to the model. Since there is only 

one element through the thickness for this model, 20-noded brick elements will be 

used. Click the Assign Element Type icon  in the model tree and the Element 

Type dialog box will appear. Under the Geometric Order option choose 

Quadratic. The Element Type dialog box should look similar to Figure 16. 

 
Figure 16. Element Type (C3D20R) 
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Creating an Instance 

 Now that the part has been meshed, it can be brought into the assembly. To do 

this task, click the + to the left of Assembly in the model tree. The model tree will 

expand and should look identical to Figure 17.  

 
Figure 17. Model Tree Expansion (Assembly) 

 

 Double click on the Instances icon in the expanded model tree. This feature will 

allow multiple parts to be brought into the assembly.  The Create Instance dialog 

box will appear (Figure 18).  

 
Figure 18. Create Instance Dialog Box 

 

 The SOLID part is selected by default because only one part has been created for 

this tutorial. If multiple parts had been created, then this step would allow them to 

be entered into the assembly.  

 Click OK. If this step was done correctly the model should turn a blue color 

(Figure 19). 
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Figure 19. Create Instance  

 

Creating a Step 

 A Step is where the user defines the type of loading, e.g. Static or Dynamic, and 

defines the boundary conditions, e.g. support constraints and forces. 

 In the model tree, double click the Steps icon. The Create Step dialog box will 

appear (Figure 20a). Create a Name: for the step called FREQUENCY. Under 

Procedure type choose Linear perturbation, Frequency. The Create Step 

dialog box should look identical to Figure 20b. 

                                                     
        Figure 20a. Create Step Dialog Box                 Figure 20b. Create Step Dialog Box (FREQ) 
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 Click Continue…, and the Edit Step dialog box will immediately appear. Under 

the Number of eigenvalues requested: option click Value: and enter 3. The Edit 

Step dialog box should look similar to that in Figure 21. 

 
Figure 21. Edit Step Dialog Box 

 Click OK.  

Apply Constraint Boundary Conditions 

 Boundary conditions will be defined which will simulate a fixed (also known as 

“clamped”) beam at one end.  

 Double click BCs in the model tree and the Create Boundary Condition dialog 

box will appear (Figure 22a). Create a Name: for the boundary condition called 

FIXED, and under the Step drop down menu make sure to choose 

FREQUENCY. Under the Category option choose Mechanical, and choose 

Symmetry/Antisymmetry/Encastre under the Types for Selected Step option. 

The Create Boundary Condition dialog box should look identical to that in 

Figure 22b.   

                                                     
                       Figure 22a. Create BC                                 Figure 22b. Create BC (FIXED) 
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 Click Continue… 

 While holding the Ctrl and Alt keys on the computer keyboard click and drag the 

cursor to rotate the part in the viewport. Another way to rotate the part would be 

to hit F3 on the computer keyboard to enter the rotation tool. When the rotation 

has been completed press Esc on your keyboard to exit the tool.  

 Rotate the part such that the left end of the beam (which was previously hidden 

due to the isometric view) is in visible in the viewport. Using the cursor click the 

face of the model which is to be constrained. If this is done correctly selected 

surface will turn from a blue to purple color.  

 Click Done. 

 The Edit Boundary Condition dialog box will immediately appear. Click 

ENCASTRE (U1=U2=U3=UR1=UR2=UR3=0). The Edit Boundary Condition 

dialog box should look identical to that in Figure 23. 

 
Figure 23. Edit Boundary Condition Dialog Box (FIXED) 

 

 Click OK. If this procedure has been done correctly, the model should look 

similar to that in Figure 24. 

 
Figure 24. Cantilever Beam (w/ BC’s) 
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Creating a Job 

 To create a job for this model, double click the Jobs icon in the model tree. Up to 

this point, you have been preprocessing the model.  A job will take the input file 

created by the preprocessor and process the model, i.e. perform the analysis.   

 In the Create Job dialog box, create a Name: for this job called 

CANTILEVER_SOLIDS. Blank spaces are not allowed in a job name.  Thus the 

use of the underscore in the name.  The Create Job dialog box should look 

identical to that in Figure 25. 

 
Figure 25. Create Job Dialog Box (CANTILEVER_SOLIDS) 

 

 Click Continue… 

 The Edit Job dialog box will immediately appear (Figure 26).  

 
Figure 26. Edit Job Dialog Box 

 

 Accept the default values and click OK. 
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Setting the Work Directory 

 To ensure that the input files write to the correct folder, setting the work directory 

must be accomplished. At the top of the screen, click File and in the dropdown 

menu click Set Work Directory… (Figure 27). 

 
Figure 27. Set Work Directory 

 

 The Set Work Directory screen will immediately appear (Figure 28). Click 

Select… and use standard Windows practice to select (and possibly create) a 

subdirectory.  

 
Figure 28. Set Work Directory (FOLDERS) 

 Click OK.  

 Click OK. 
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Writing the Input File (.inp) 

 To write the input file of the job that was created, first click the + next to the 

Jobs(1) icon in the model tree. 

 Right click the job called CANTILEVER_SOLIDS and click the Write Input 

option. This choice will write an input file (.inp) of this model to the work 

directory.  

 It may be helpful to go to the folder on the computer to which the work directory 

is set to ensure that the input file was written there.  

Model Analysis (Abaqus Command)   

 Method #1 

 Go to the Start Menu and open Abaqus Command 

 Abaqus is set to a default directory (Example C:\>). To change directories in the 

Abaqus Command type the directory of choice followed by a colon (D:) then hit 

Enter. 

 To access a specific directory within that drive type cd followed by the specific 

folder name in that directory (e.g., cd users) then hit Enter. 

 Now that the correct directory has been sourced in the command window type 

abaqus inter j=CANTILEVER_SOLIDS and then hit enter. 

 If the job has completed successfully the Abaqus prompt should look similar to 

Figure 29. 

 
Figure 29.  Abaqus Command Prompt (COMPLETED) 
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 Method #2 

 An alternative method for submitting an *.inp file for processing by Abaqus can 

be accomplished with Abaqus CAE 

 Right click the job called CANTILEVER_SOLIDS and click the Submit option. 

If you see a warning (Figure 30) Click OK.  The intent of this warning is to 

prevent the user from accidentally overwriting a previously completed analysis 

with the same name. 

 

 
Figure 30. Warning Message 

 

 The model will now be submitted for analysis by Abaqus and the progress can be 

viewed in the status window at the bottom of the screen (Figure 31). 

 

 
Figure 31. Abaqus Progress 

Postprocessing using Abaqus CAE 

 After the analysis has successfully completed in the Abaqus Command window 

using Method #1 or using Method #2, return to view the Abaqus CAE viewport.  

 Because the last step of creating the model was to create a job/write (and possibly 

submit) an input file, the CANTILEVER_SOLIDS job should still be highlighted 

in Abaqus CAE model tree. Right click the CANTILEVER_SOLIDS and then 

click Results.  

 If this selection was done correctly, the model should turn to a green color and the 

beam will have rotated to an isometric view (Figure 32). 
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Figure 32. Analysis Results Isometric View 

 

 To rotate the model back into the X Y plane for viewing, click View in the toolbar 

at the top of the screen. Next, Click Toolbars and make sure the option Views has 

a check mark to the left of it.  If not, then click it.  

 The Views toolbar will appear (Figure 33), and the Apply Front View button can 

be clicked to view the model in the X Y plane.   

 
Figure 33. Views Toolbar 

 

 To view the deformed shape of the model, click the Plot Contours on Deformed 

Shape icon   in the Visualization module. The model should look similar to 

that in Figure 34. 
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Figure 34. Deformed Shape 

 

Obtaining Frequencies and Mode Shapes 

 The natural frequencies and corresponding mode shapes can be found in the 

viewport. The natural frequency of the beam shown in Figure 34 occurs at 42.51 

Hz. This numerical value can be seen at the bottom of the viewport (Figure 35). 

  
Figure 35. Natural Frequency of Bending Mode 1 

 

 The corresponding mode shape occurring at this frequency is shown by the 

contour plot shown in Figure 34. To view the other modes that were requested by 

the analysis click the arrow icon  at the top right of the viewport.  

 The corresponding mode shapes and frequencies will appear in the viewport as 

the arrow icon is clicked.  
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Conclusion 

 Save the file by doing either File > Save or clicking the disk icon (Figure 36). 

 

 
Figure 36. Disk Icon (Saving) 

 

 Close Abaqus CAE:  File > Exit or Ctrl+Q 

 This completes the Finite Element Analysis of a Cantilever Beam (Eigensolution 

– Solid Model).  
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